
Mary eta lambda this month – and then created a semantic model using Fabric and Copilot to blow 
its entire savings in the bank!  Or something like that.  It’s a huge month for Microsoft releases as we say goodbye to 2023, with three new Excel 
functions, eta lambda capability, Fabric and Copilot all coming into play!  Learn more on all these topics in our mammoth newsletter this month.

It's been a big month for SumProduct too – our team continues to grow – and we are delighted to announce a key new member to the posse, 
Loretta Ross, who has become our Head of Sales and Product Strategy.  This role has been vacant for sometime: finding the right person has been an 
immense challenge for us and we think she will do a fabulous job for us.  You can meet her in this month’s newsletter below.

This month we look at another common request in recent months – data validation lists.  And then there are the regulars: Beat the Boredom 
Challenge, plus more tips on Charts & Dashboards, our still reasonably new Excel for Mac article, plus Visual Basics, 
Power Pivot Principles, Power Query Pointers, Power BI Updates and Excel Updates.  We also take the P in our A to Z of 
Keyboard Shortcuts and we even MDETERM what to put in this month’s A to Z of Excel functions.  

As always, happy reading and remember: stay safe, stay happy, stay healthy.
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How can we kick off this month’s newsletter without welcoming our 
newest member of the SumProduct family, Loretta Ross, Head of Sales 
and Product Strategy.

Loretta brings a wealth of experience to SumProduct having worked at 
CPA Australia for the past 10 years, where she was responsible for a large 
and diverse portfolio of commercial learning products and services.  In 
this time, she established and grew the CPA Australia in-house learning 

and consultancy business into a global powerhouse, featuring a broad 
range of offerings that were often tailored to customers’ specific needs 
and provided quantifiable return on investments. 

Before CPA Australia, Loretta spent 12 years in the financial services 
industry partnering with financial advisors to upskill on a wide range 
of technical, technological and transferrable skills to keep pace with an 
ever-changing and dynamic business environment.

Please Welcome Our New Head of Sales and Product Strategy, Loretta Ross
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Loretta has a passion for connecting with people from all parts of the 
world, discovering their problems, often complex in nature, and finding 
the best solutions to help them learn, unlearn and re-learn new skills to 
reach their potential.  There is no problem too big or small to solve, only 
the opportunity to be more productive and in turn, enable organisations 
and its people to focus on value-adding and strategic business priorities.

She is looking forward to working with the SumProduct team to innovate 
and develop the online learning and in-person training offerings and 
provide value through commercial partnerships with the global finance 
and accounting community.  The number one goal is to build mutually 

rewarding partnerships with a wide range of organisations to help them 
reach their goals. 

If you work in an organisation that could benefit from learning new 
skills in the world of Microsoft Excel, Power BI and more, or know of 
anyone who does, don’t hesitate to get in touch with Loretta on loretta.
ross@sumproduct.com.  She will be more than happy to arrange a call 
to discuss your needs.

Welcome Loretta!

In addition to the Excel Updates mentioned later in this newsletter, Microsoft has announced three new functions and “eta reduced lambda” 
functions (known as “eta lambdas”) into the Excel family in the past couple of weeks.  They make automating data analysis really simple – as long as 
you have access to all of these functions!  They are rolling out on the beta channel for Excel for Windows and Excel for Mac as we write.

GROUPBY, PIVOTBY, PERCENTOF, Eta Lambdas et al

eta Lambdas

These “eta reduced lambda” functions may sound scary, but they make the world of dynamic arrays more accessible to the inexperienced.  They help 
make the other three functions simpler to use.  Dynamic array calculations using basic aggregation functions often require syntax such as

LAMBDA(x, SUM(x))

LAMBDA(y, AVERAGE(y))

etc.

However, given x and y (above) are merely dummy variables, an “eta lambda” function simply replaces the need for this structure with the so-easy-
anyone-can-understand-it syntax of

SUM

AVERAGE

etc.

Even I can do it.  For example, consider the following formula in cell G17 below:

=BYCOL(G13:J16,LAMBDA(x,SUM(x)))

This sums the range G13:J16 by column using that LAMBDA(x, SUM(x)) trick.  But there is no need for this anymore, viz.

=BYCOL(G21:J24,SUM)
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That’s much simpler! 

Presently, the following built-in functions are available to Excel users lucky enough to get all these functions and functionalities:

These will pop up when they may be used, but they don’t appear in alphabetical order.  It’s more a ranking of what Microsoft perceives to be the 
most common aggregation operations:

•	 ARRAYTOTEXT
•	 AVERAGE
•	 CONCAT
•	 COUNT

•	 COUNTA
•	 MAX
•	 MEDIAN
•	 MIN

•	 MODE.SNGL
•	 PERCENTOF
•	 PRODUCT
•	 STDEV.P

•	 STDEV.S
•	 SUM
•	 VAR.P
•	 VAR.S

GROUPBY

The new GROUPBY function allows you to create a summary of your data formulaically.  It supports grouping along one axis and aggregating the 
associated values.  For instance, if you had a table of sales data, you might generate a summary of sales by year, or by salesperson, or by category, 
or by…

In essence, it allows you to group, aggregate, sort and filter data based upon the fields you specify.

The syntax of the GROUPBY function is given by:

GROUPBY(row_fields, values, function, [field_headers], [total_depth], [sort_order], [filter_array])

It has the following arguments:

	 •	 row_fields: this is required, and represents a column-oriented array or range that contains the values which are used to group rows and 	
		  generate row headers.  The array or range may contain multiple columns.  If so, the output will have multiple row group levels

	 •	 values: this is also required, and denotes a column-oriented array or range of the data to aggregate.  The array or range may contain  
		  multiple columns.  If so, the output will have multiple aggregations

	 •	 function: also required, this is an explicit or eta reduced lambda (e.g. SUM, PERCENTOF, AVERAGE, COUNT) that is used to aggregate  
		  values.  A vector of lambdas may be provided.  If so, the output will have multiple aggregations.  The orientation of the vector will 	
		  determine whether they are laid out row- or column-wise

	 •	 field_headers: this and the remaining arguments are all optional.  This represents a number that specifies whether the row_fields and  
		  values have headers and whether field headers should be returned in the results.  The possible values are:

			   ○	 Missing: Automatic

			   ○	 0: No 
			   ○	 1: Yes and don't show 
			   ○	 2: No but generate
			   ○	 3: Yes and show

It should be noted that “Automatic” assumes the data contains headers based upon the values argument.  If the first value is text and the 
second value is a number, then the data is assumed to have headers.  Fields headers are shown if there are multiple row or column group levels 
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	 •	 total_depth: this optional argument determines whether the row headers should contain totals.  The possible values are:

			   ○	 Missing: Automatic, with grand totals and, where possible, subtotals
			   ○	 0: No Totals
			   ○	 1: Grand Totals
			   ○	 2: Grand and Subtotals
			   ○	 -1: Grand Totals at Top
			   ○	 -2: Grand and Subtotals at Top 

 		  It should be noted that for subtotals, fields must have at least two [2] columns. Numbers greater than two [2] are supported provided there  
		  are sufficient columns 

	 •	 sort_order: again optional, this argument denotes a number indicating how rows should be sorted.  Numbers 			 
		  correspond with the columns in row_fields followed by the columns in values.  If the number is negative, the rows are sorted in descending  
		  / reverse order.  A vector of numbers may be provided when sorting based upon only row_fields

	 •	 filter_array: the final optional argument, this represents a column-oriented one-dimensional array of Boolean values [1, 0] that indicate  
		  whether the corresponding row of data should be considered.  It should be noted that the length of the array must match the length of  
		  row_fields.

To show how GROUPBY works, we took inspiration from Microsoft’s data table:

I have converted this data table into an Excel Table by selecting all the data and using Insert -> Table (CTRL + T) and calling the resultant Table tbl.  
Look, it’s late as I write this and I have no imagination, OK!?

I can summarise my Table very simply using the formula

=GROUPBY(tbl[Category],tbl[Sales],SUM)
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How easy is that!?  Essentially, I am summing the sales (using the eta lambda SUM) by the Category field.

If you want to aggregate by more than one row_field, as stated above, this is possible.  One way is to use HSTACK:

=GROUPBY(HSTACK(tbl[Year],tbl[Category]),tbl[Sales],SUM)

This simply combines the Year and Category fields in the tbl Table, and then sums Sales across them.  However, I think I prefer the CHOOSECOLS 
approach:

=GROUPBY(CHOOSECOLS(tbl,1,2),tbl[Sales],SUM)

Here, the idea is that I shall SUM Sales by columns 1 (Year) and 2 (Category) of the tbl Table.  This might not seem as clear as the HSTACK alternative 
at first glance as you have to refer to the Table to identify what the columns are.  However, stick with me.  Let me make the formula more complex:

=GROUPBY(CHOOSECOLS(tbl,MATCH(F$12,tbl[#Headers],0), 
MATCH(G$12,tbl[#Headers],0)),tbl[Sales],SUM)

Looks horrible, yes?  I have replaced the values 1 and 2 in the previous formula with

MATCH(F$12,tbl[#Headers],0)

and

MATCH(G$12,tbl[#Headers],0)

which return the positions in the Headers row of the Table tbl.  Now, this may seem overkill but consider the following image:
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Brilliant.  I have changed the background colour of the first two headers to yellow.  Well no, it’s a little more than that.  I have used data validation 
dropdown lists (ALT + D + L) to create input headers!!

Thus, if I change the selections, I have dynamic summarisations, such as

or
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Multiple summary statistics may be created similarly, or else you can simply connect them if the reporting fields are contiguous, e.g.

=GROUPBY(CHOOSECOLS(tbl,1,2),tbl[[Sales]:[Rating]],AVERAGE)

Here, tbl[[Sales]:[Rating]] may be used to specify the values as they are side by side.

Obviously, there are many more arguments to play with, but hopefully, you get the general idea, such as ranking the Item field in descending order 
by Sales using the formula 

=GROUPBY(tbl[Item],tbl[Sales],SUM,,,-2)
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Indeed, the outputs summarised don’t have to be numerical.  A more comprehensive example summarising the Items field might look like this:

=GROUPBY(tbl[Category],tbl[Item],LAMBDA(x,ARRAYTOTEXT(SORT(UNIQUE(x)))))

PIVOTBY

The PIVOTBY function allows you to create a summary of your data via a formula too, akin to a formulaic PivotTable.  It supports grouping along two 
axes and aggregating the associated values.  For instance, if you had a table of sales data, you might generate a summary of sales by state and year.

It should be noted that PIVOTBY is a function that returns an array of values that can spill to the grid.  Furthermore, at this stage, not all features of 
a PivotTable appear to be replicable by this function.

The syntax of the PIVOTBY function is:

PIVOTBY(row_fields, col_fields, values, function, [field_headers], [row_total_depth], [row_sort_order], [col_total_depth], [col_sort_order], 
[filter_array])

It has the following arguments:

	 •	 row_fields: this is required, and represents a column-oriented array or range that contains the values which are used to group rows and 	
		  generate row headers.  The array or range may contain multiple columns.  If so, the output will have multiple row group levels

	 •	 col_fields: also required, and represents a column-oriented array or range that contains the values which are used to group columns and 	
		  generate column headers.  The array or range may contain multiple columns.  If so, the output will have multiple column group levels

	 •	 values: this is also required, and denotes a column-oriented array or range of the data to aggregate.  The array or range may contain 	
		  multiple columns.  If so, the output will have multiple aggregations

	 •	 function: also required, this is an explicit or eta reduced lambda (e.g. SUM, PERCENTOF, AVERAGE, COUNT) that is used to aggregate  
		  values.  A vector of lambdas may be provided.  If so, the output will have multiple aggregations.  The orientation of the vector will  
		  determine whether they are laid out row- or column-wise 
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	 •	 field_headers: this and the remaining arguments are all optional.  This represents a number that specifies whether the row_fields, col_	
	 	 fields and values have headers and whether field headers should be returned in the results.  The possible values are:

			   ○	 Missing: Automatic
			   ○	 0: No 
			   ○	 1: Yes and don't show 
			   ○	 2: No but generate
			   ○	 3: Yes and show

		  It should be noted that “Automatic” assumes the data contains headers based upon the values argument.  If the first value is text and the 	
		  second value is a number, then the data is assumed to have headers.  Fields headers are shown if there are multiple row or column group levels

	 •	 row_total_depth: this optional argument determines whether the row headers should contain totals.  The possible values are:

			   ○	 Missing: Automatic, with grand totals and, where possible, subtotals
			   ○	 0: No Totals
			   ○	 1: Grand Totals
			   ○	 2: Grand and Subtotals
			   ○	 -1: Grand Totals at Top
			   ○	 -2: Grand and Subtotals at Top 

		  It should be noted that for subtotals, row_fields must have at least two [2] columns. Numbers greater than two [2] are supported provided  
		  row_field has sufficient columns

	 •	 row_sort_order: again optional, this argument denotes a number indicating how rows should be sorted.  Numbers correspond with the  
		  columns in row_fields followed by the columns in values.  If the number is negative, the rows are sorted in descending / reverse order.  A  
		  vector of numbers may be provided when sorting based upon only row_fields

	 •	 col_total_depth: this optional argument determines whether the column headers should contain totals.  The possible values are:

			   ○	 Missing: Automatic, with grand totals and, where possible, subtotals
			   ○	 0: No Totals
			   ○	 1: Grand Totals
			   ○	 2: Grand and Subtotals
			   ○	 -1: Grand Totals at Top
			   ○	 -2: Grand and Subtotals at Top 

		  It should be noted that for subtotals, col_fields must have at least two [2] columns. Numbers greater than two [2] are supported provided 	
		  col_field has sufficient columns

	 •	 col_sort_order: again optional, this argument denotes a number indicating how they should be sorted.  Numbers correspond with the 	
		  columns in col_fields followed by the columns in values.  If the number is negative, these are sorted in descending / reverse order.  A 	
		  vector of numbers may be provided when sorting based upon only col_fields

	 •	 filter_array: the final optional argument, this represents a column-oriented one-dimensional array of Boolean values [1, 0] that indicate 	
		  whether the corresponding row of data should be considered.  It should be noted that the length of the array must match the length of 	
		  row_fields and col_fields.

Similar in many ways to GROUPBY, PIVOTBY is fairly straightforward to use:

=PIVOTBY(tbl[Category],tbl[Year],tbl[Sales],AVERAGE) 

You can get more imaginative and sort in descending order by the AVERAGE of Rating, viz.

=PIVOTBY(tbl[Item],tbl[Year],tbl[Rating],AVERAGE,,,-2)
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PERCENTOF

This final function can be used in conjunction with GROUPBY and PIVOTBY, or else on its own.  This is used to return the percentage that a subset 
makes up of a given dataset.  It is logically equivalent to

SUM(subset) / SUM(everything)

It sums the values in the subset of the dataset and divides it by the sum of all the values.  It has the following syntax:

=PERCENTOF(data_subset, data_all)

The arguments are as follows:

	 •	 data_subset: this is required, and represents the values that are in the data subset
	 •	 data_all: this too is required, and denotes the values that make up the entire set.

You can use it, for example, with GROUPBY:

=GROUPBY(tbl[Category],tbl[Sales],PERCENTOF)

Alternatively, it may be used on its own:

=PERCENTOF(G13:G14,G13:G16)
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Word to the Wise

Do remember these functions have just come out.  At the time of writing, they are rolling out to users enrolled in the beta channel for Windows 
Excel and Mac Excel.  Don’t be upset if you don’t get them straight away – they are coming!

It is possible the syntax for these functions might change (this happened with RANDARRAY for instance), so do be careful.  There may be bugs too.  
Indeed, I have noted the following so far:

	 •	 there is nothing to prohibit creating a named range with the same name as an eta lambda, e.g. SUM.  This can cause the formula to 	
		  produce an #VALUE! error.  To distinguish between an eta lambda and a range name with the same moniker, use _xleta. as a prefix which 	
		  might update automatically, e.g.

		  =GROUPBY(tbl[Category], tbl[Sales], _xleta.SUM)

	 •	 it has been noted already within the Excel community that titles do not always seem to fully appear:

		  =GROUPBY(F12:G20,H12:H20,SUM,3,0)

These functions are still fledgling, and hopefully such issues shall be rectified soon.  

Don’t let these minor gremlins (and others you may find) deter you!

We are pleased to announce a new training course is coming to our 
portfolio in the New Year – ChatGPT – with a focus on those working 
in finance, accounting and banking (but available to all).  Its aim will to 
show you how to embrace chatbot technology to aid productivity and 
not be in fear of your job!!

As a taster, SumProduct analyst Myles Kuah decided to have a play and 
create a “specialised” GPT where he uploaded our very own Financial 
Modelling book:

ChatGPT Training – Coming in 2024!
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In effect, he created a “Financial Modelbot’ that digested all of Liam Bastick’s thoughts on Financial Modelling so that the AI’s brains may be picked.  
So he had a try:

It’s a shame it’s not “Best Practice” (i.e. a proper noun to denote a concept to aspire to, rather than something that may always be achieved), but it’s 
not a bad draft.  I like the flowery wittering: I’m loving “model road rage”!

But Myles didn’t stop there.  Oh no, we have trained him well!  He enquired about tax…
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Right, I’m off to paint hot knives through swans for a Mondrian painting (once I have found out what one is)…

If you wish to find out more about ChatGPT training (or any of our training for that matter) and how it can revolutionise your workload, drop us a 
line at training@sumproduct.com.

No swans were hurt during the making of this article.  Unfortunately, we can’t say the same for the butter.

Australian Institute of Training and Development (AITD) Beaten Finalist
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Well, we didn’t win – but we were shortlisted for the second year 
running!  The Australian Institute of Training and Development (AITD) 
Excellence Awards recognise outstanding achievement in organisational 
learning and development.  We mentioned recently that SumProduct 
was recognised as a contributor to a project which achieved finalist 
status in the AITD 2023 Awards.  Alas, for the second year running, we 
made the shortlist, but we had to settle for another bridesmaid’s dress 
(I always think they look nicer than the dresses I wear anyway…).  We’ll 
have to hope for third time lucky!

Projects entered in the AITD Excellence Awards were assessed against 
specific award criteria including business needs, strategic alignment, 
design, delivery and measurable impact by an independent judging panel.  
Entrants had to provide evidence to demonstrate a high achievement 
against these criteria to be awarded finalist status.  Therefore, jokes 
aside, we were delighted to have been nominated once again.  It’s great 
to be recognised for the work both our team and our client performed.  
In any case, the gang had fun up on the Gold Coast!

Pictured: Tim Heng and our new Head of Sales and Product Strategy, Loretta Ross.  Why do they both have better teeth than me?   
We’ll let you figure out who is who…

If you would like to find out how our standard or customised training programs can benefit you and your team, drop us a line at training@sumproduct.com.

You will see later in this month’s newsletter that there are a significant 
number of updates for Power BI this month.  We mention the updates 
again there, but summarise them here.  

These updates include the General Availability of Microsoft Fabric and 
the public Preview of Copilot in Microsoft Fabric, including the experience 
for Power BI.  With the launch of these next-generation analytics tools, 
you can empower your data teams to more easily scale to meet the 
demand of the business.  

Microsoft Fabric is reshaping how teams work with data by bringing 
everyone together on a single end-to-end analytics platform.  Data 

analysts can work side-by-side with data engineers, data warehousing 
professionals, data scientists, and business users, all working in the same 
software as a service (SaaS) experience and from the same unified data 
lake, OneLake, to uncover insights.  

Microsoft also believes Copilot in Fabric has the potential to dramatically 
change the way organisations work with data.  Seasoned business 
intelligence professionals can use Copilot to scale and create stunning 
reports faster.  Less skilled users can use Copilot to explore their data, 
create reports, and answer their questions without burdening their data 
teams.

Fabric and Copilot in Power BI

General Availability of Microsoft Fabric

Microsoft Fabric is now out there.  It is an end-to-end data platform that can reshape how everyone accesses, manages and acts on data and insights 
by connecting every data source and analytics service together.

There are four [4] ways Microsoft Fabric may assist the current analytics market:

	 1.	 Fabric is a complete analytics platform.  By bringing together seven [7] role-specific workloads, Data Factory, Data Engineering, Data  
		  Warehouse, Data Science, Real-Time Analytics, Data Activator and Power BI, into a single, unified experience and architecture, Fabric  
		  can help to reduce the typical cost and effort of integrating services and streamline your data estate.  This unified architecture also 	
		  simplifies both governance with built-in features that span every workload and billing with a single pool of capacity and storage that can 	
		  be used for every workload
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Announcing the public Preview of Copilot in Microsoft Fabric

	 2.	 Fabric is lake-centric and open.  You can easily connect all your data across clouds, accounts and domains to Fabric’s unified, multi cloud 	
	 	 data lake, OneLake, to create a single source of truth for your data.  OneLake is automatically wired into every Fabric workload and with 	
	 	 OneLake’s open data format, you only need to load the data into the lake once to use it across every Fabric workload and engine, 	
	 	 minimising data duplication and sprawl

	 3.	 Fabric empowers business users.  It can ensure business users in your organisation have access to the data and insights needed to make 	
	 	 data-driven decisions.  With Power BI natively built into Fabric, anyone can quickly go from data sitting in a lake to bespoke Power BI 	
	 	 visuals embedded in a Microsoft 365 app

	 4.	 Fabric is AI-powered.  It has infused AI to help data professionals get more done, more quickly.  With Copilot in Fabric, you can use 	
	 	 natural language to create dataflows and pipelines, write SQL statements, build reports or even develop machine learning models.

There is also the announcement of the public Preview of Copilot in 
Microsoft Fabric, including the experience for Power BI, which helps 
users quickly get started by helping them create reports in the Power BI 
web experience.  Based upon a high-level prompt, Copilot for Power BI 
in Fabric creates an entire report page for you by identifying the tables, 

fields, measures and charts that would help you get started.  You can 
then customise the page using.  Copilot can also help you understand 
your semantic model and even suggest topics for your report pages.  It’s 
a fast and easy way to get started with a report, especially if you’re less 
familiar with report creation in Power BI.

In addition to report creation, Copilot’s ability to summarise data has 
been brought to the ‘Smart Narrative’ visual, now rebranded as the 
‘Narrative with Copilot’ visual.  This visual summarises the data and 

insights on the page, across your report or even for your own template 
if you need to define a specific summary.  This visual is available in the 
Power BI service and in Power BI Desktop.
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Lastly, in Power BI Desktop, Copilot can help model authors improve 
their models and save time.  The first capability is being released now, 
and helps authors generate synonyms for their fields, measures and 
tables using Copilot.  But this is just the start.  Future Power BI Desktop 
updates will bring even more new Copilot experiences, including the 
report creation experience from the Service, a Data Analysis Expressions 
(DAX) writing experience, and more.  

The Preview of Copilot in Microsoft Fabric will be rolling out in stages 
with the goal that all customers with Power BI Premium capacity (P1 or 
higher) or Fabric capacity (F64 or higher) will have access to the Copilot 
preview by the end of March 2024.  You don’t need to sign up to join the 
Preview, it will automatically become available to you as a new setting 
in the Fabric administrator (admin) portal when it is rolled out to your 
tenant.  When charging begins for the Copilot in Fabric experiences, you 
can simply count Copilot usage against your existing Fabric or Power BI 
Premium capacity.  

Power BI semantic model support for Direct Lake on Synapse Data Warehouse

Announcing public Preview of stored credentials for Direct Lake semantic model Row Level Security (RLS) and Object Level Security (OLS)

Instantly integrate your import-mode semantic models into OneLake

Quickly answer your data questions with Explore

The Power BI semantic models can now leverage Direct Lake mode in 
conjunction with Synapse Data Warehouses in Microsoft Fabric.  Until 
now, Direct Lake mode was limited to semantic models on Fabric 
lakehouses, whilst warehouses were queried only in DirectQuery mode.  
Now, Microsoft has expanded Direct Lake mode to support warehouses 

in Fabric as well.  Direct Lake mode is a groundbreaking data access 
technology for semantic models based on loading Delta-Parquet files 
directly from OneLake without having to import or duplicate the data.  
Direct Lake combines the advantages of import and DirectQuery modes 
to deliver quick query performance without any data movement. 

This latest set of updates also sees the public Preview of Row Level 
Security (RLS) and Object Level Security (OLS) and stored credentials 
for Direct Lake semantic models.  RLS and OLS is a Power BI feature 
that enables you to define row-level and object-level access rules in a 
semantic model, so different users can see different subsets of the data 
based on their roles and permissions.  

Stored credentials help reduce configuration complexity and are strongly 
recommended when using RLS and OLS with Direct Lake semantic 
models. The following screenshot shows how you can add users to RLS 
roles in a Direct Lake model using the web modelling experience. 

There is also the public Preview of Microsoft OneLake integration for 
import models.  With the flick of a switch, you can enable OneLake 
integration and automatically write data imported into your semantic 
models to delta tables in OneLake and enjoy the benefits of Fabric without 
any migration effort.  The data is instantly and concurrently accessible 

through these delta tables.  Data scientists, database administrators, 
app developers, data engineers, citizen developers and any other type of 
data consumer now have direct access to the same data that drives your 
business intelligence. 

Another public Preview feature called Explore has been announced 
that will enable anyone to quickly explore a semantic model.  Similar to 
exporting and building a PivotTable in Excel, you can open the Explore 
experience and create a matrix or visual view for your data.  Analysts 

could use Explore to learn about a new semantic model before building 
a report for example or a business user could answer a specific question 
they have about the data without building an entire report.

The web modelling security roles dialog will be fully deployed in the coming days or weeks.  
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Announcing the public Preview of Data Analysis Expressions Query view

Announcing the General Availability of semantic model scale-out, now with Direct Lake compatibility

DAX queries help you quickly explore and analyse your semantic 
model.  The new DAX query view in Power BI Desktop lets you utilise 
the powerful DAX query language to discover, analyse and see the 
data in your semantic model.  Like the Explore feature (above), model 
authors can quickly validate data and measures in their semantic model 
without having to build a visual or use an additional tool.  Changes made 
to measures can be seamlessly updated directly back to the semantic 
model.  This capability along with several existing features like auto 
formatting, integration with the Report View’s Performance Analyzer, 

quick measures and measure-reference expansion all mean DAX query 
authoring in Power BI have just become much more productive for data 
professionals and advanced data analysts.

Microsoft has stated that they plan to continue adding functionality 
to the ‘DAX Query view’, including Copilot integration, support for live 
connect reports and adding it to the Power BI Service.  You may get 
started by turning on this public Preview feature in Power BI Desktop 
Options -> Preview features.

The semantic model scale-out is now Generally Available.  With scale-
out, Power BI automatically scales out read-only replicas to ensure there 
are no performance slowdowns when many users are using the system 
at the same time, enabling large-scale production solutions to support 
high user concurrency.  Automatic scale-out now works for Direct Lake 
semantic models too.  Additionally, import-mode semantic models will 
benefit from refresh isolation, ensuring business users are unaffected 
by resource-intensive refresh operation, and continue to enjoy quick 
queries for interactive analysis.

Semantic-model scale-out is the last of the key features to make Microsoft 
Fabric and Power BI a superset of Microsoft Azure Analysis Services.  
Scale-out in Fabric is even superior to Analysis Services since scale-out 
takes place based on live user demand and adjusts automatically to 
changes in usage patterns.  Analysis Services on the other hand requires 
detailed analysis to determine peak usage times, create automation 
scripts and monitor to ensure optimum set up.  Additionally, cost in 
Analysis Services increases linearly per replica, unlike Fabric’s usage-
based billing model.
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New Microsoft Fabric licensing options

Getting started with Power BI and Microsoft Fabric

In June 2023, Microsoft announced pay-as-you-go prices for Fabric that 
allow you to dynamically scale up or scale down and pause capacity as 
needed.  There is now “reservation pricing” for Fabric that will allow you 
to pre-commit Fabric Capacity Units in one-year increments, helping 
you save up to 40% over the pay-as-you-go prices (excluding Power 
BI Premium capacity SKUs).  Microsoft has also announced OneLake 
business continuity and disaster recovery (BCDR) and cache storage 

prices, expanding on their already announced OneLake storage pricing.  
You may check out all these pricing options on the Microsoft Fabric 
pricing page. 

With these announcements, current Power BI Premium per capacity 
customers have an additional pricing option to experience everything 
Fabric has to offer. 

If you are an existing Power BI Premium per capacity customer, you can 
already access Microsoft Fabric by simply turning on Fabric in your admin 
portal. 

If you don’t already have Power BI Premium capacity, you can try out 
everything Fabric has to offer by signing up for the free trial — no credit 

card information is required.  To start your free trial, sign up for a free 
account (Power BI customers can use their existing account), and once 
signed in, select Start Trial within the account manager tool in the Fabric 
app. Each trial user will receive a 64 CU trial capacity — your billing unit 
— to use against any workload during your 60-day free trial. 

We have seen feedback for Excel for the web that when typing invalid data an animated dialog appears.  Cool!

These dialogs are definitely getting fancier.  But more than that, it got 
us thinking.  It triggered an old memory.

We have some twisted individuals reading these newsletters!  By far 
and away the most popular ‘trick’ (in all sense of the word!) was this 
monster first divulged way back in our very first newsletter.

Data Validation is a useful way to control what end users can type 
into a worksheet cell (see www.sumproduct.com/thought/data-
validation). You can use this functionality to play a trick.  Please use 
this at your own risk: if you get fired, you will get no sympathy here.

If someone is unfortunate to leave a spreadsheet unprotected, simply 
highlight the whole worksheet and then activate Data Validation (ALT + 
D + L).  In the ‘Settings’ tab, select settings similar to the following (the 
aim is to pick a number the user won’t use):

Celebrating Data Validation Lists
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Then, select the ‘Error Alert’ tab:

Now, de-select the range and wait for your victim to use the worksheet.  As soon as they type an invalid entry, they will be greeted with the following 
error alert:

Who says spreadsheets can’t be fun..? 

With many of us currently “working from home” / quarantined, there are 
only so Zoom / Teams calls and virtual parties you can make before you 
reach your (data) limit.  Perhaps they should measure data allowance 
in blood pressure millimetres of mercury (mmHg).  To try and keep our 

readers engaged, we will continue to reproduce some of our popular  
Final Friday Fix challenges from yesteryear in this and upcoming 
newsletters.  One suggested solution may be found later in this newsletter.  
Here’s this month’s…

How do you create a series of dropdown boxes so that they feed off each 
other?  For example, given data validation with a car make (manufacturer, 
in layman’s terms), how can that populate the next data validation to list 
the models associated with only that make, then the variants associated 
with that model and year of manufacture, and so on?

Now, this is not a difficult question – Google will generally provide an 
answer involving the INDIRECT function and creating a named range for 

each list you want to use.  For example, we have three Toyota vehicles 
in our list, so you would set up a named range called “Toyota”, so when 
you enter in that value in the “make” cell, the data validation will point 
to =INDIRECT(“Toyota”), which gives you the list of three models that we 
have in our data set.

However, this results in two primary problems:

	 • 	 doing this will result in a LOT of named ranges.  Taking this approach will create one named range for each possible make, plus one n	
	 	 amed range for each model within each make, and another named range for each possible year within that model – this leading on to the 	
	 	 second issue…

	 •	 if you have repeated items such as the year of manufacture, there is no way to distinguish between a 2018 Corolla and a 2018 Fiesta.  	
	 	 Therefore, you will need to have a combination of named ranges such as 2018Corolla, 2017Corolla, 2016Corolla, so you can pick out the 	
	 	 relevant variants specific to each year.  For the record, in Australia, there were 19 different variants of the Ford Focus manufactured in 	
	 	 2017.  Yuck (that’s a comment on the number of combinations, not the car models, but having said that…).

Beat the Boredom Challenge
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This all seems a bit messy.  So here is our challenge for this month: can you come up with a way of creating a cascading set of data validated cells that 
refer back to the value selected in the previous cell, without creating a mess of named ranges in the process?

We’ve compiled a list of cars for a list of cars for you to use as a dataset 
if you wish – two different makes (Toyota and Ford), with five different 
models across the makes (Yaris, Corolla, Camry, Fiesta and Focus), 
across three different years, and no less than 161 unique variants across 
the combination of years and models.  We wish to stress that this is 

an incredibly small dataset when compared to the actual number of 
different manufacturers and models and variants available in the world, 
so it should be clear that having a solution that is scalable is going to be 
critical.  If we doubled the number of makes, models and years, we don’t 
want a solution that will require us to do a heap of work to upgrade.

Sounds easy?  Try it.  One solution just might be found later in this newsletter – but no reading ahead!

With Steve Kraynak joining the team, we thought we would exploit his 
knowledge and recant all about Microsoft Excel for Mac.  Each month, we’ll 
cover a different topic to help you understand how Excel for Mac is different 

than Excel for Windows.  This month, we’ll touch on some fundamentals to 
help you get going and be productive using Excel for Mac.

The Mac operating system is intuitive and easy to use, but if you’re familiar with Windows, and switching to Mac, or 
just starting to use Excel on the Mac, then there are some important things to know so you can make the most of it.

First things first, let’s talk about keyboard shortcuts.  The good news is that most of the keyboard shortcuts work 
similarly on Mac as they do on Windows.  Also, since Mac has both a CTRL key and a COMMAND (CMD) key, in most 
cases, Excel can use either one as the modifier key for the action you need. 

For example, to copy, you can press either CTRL + C or CMD + C.  They both work the same!

Excel for Mac

Keyboard Shortcuts
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There are a few key combinations that are different and there are good reasons for that.  The Mac has some of its own keyboard shortcuts that work 
in all applications, and Excel doesn’t override those. 

Here are some instances where CTRL and CMD don’t work the same:

	 1.	 CMD + F opens the ‘Find in Document’ dialog:

	 2.	 CTRL + F opens Excel’s ‘Find & Replace’ dialog (‘Find’ tab):

	 3.	 CMD + H will hide the current window.  This works in all apps on Mac

	 4.	 CTRL + H opens Excel’s Find & Replace dialog (‘Replace’ tab):

	 5.	 CMD + U applies underline formatting

	 6.	 CTRL + U edits the active cell and position the insertion point at the end of the line

	 7.	 CTRL + SPACE – this conflicts with a default keyboard shortcut on Mac which switches the keyboard input.  To allow this shortcut to select 	
	 	 the entire column in Excel, go to your Mac preferences -> Keyboard -> Keyboard Shortcuts -> Input Sources and disable it there

	 8.	 CMD + SPACE opens the Spotlight search on Mac.

Many people get frustrated or confused when they switch from Windows to Mac, because they’re accustomed to switching between open 
documents / apps by pressing ALT + TAB.  On Mac, there are two [2] shortcuts to know so you can easily switch between windows:

	 1. 	 CMD + ` (the button above TAB) which switches between open documents in an app

	 2.	 CMD + TAB which switches between applications.

Switching Between Workbooks or Applications (Apps)

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Unfortunately, the ALT key tips are not available in Excel for Mac, but you can voice your support for this feature in Microsoft’s community.  Please 
go vote for it at ALT key Ribbon access.

If you have any trouble or need more detailed information, Microsoft’s full list of keyboard shortcuts may have the answer.  See this article: Keyboard 
shortcuts in Excel.

We’ll continue next month…

What’s Missing

More Information

It’s time to chart our progress with an introductory series into the world of creating charts and dashboards in Excel.  This month, we consider the 
pre-work for Symbol Charts in dashboards. 

Adding symbols into tables or charts can be a great visual aid to the numbers and a helpful way to quickly communicate where end user focus is 
needed.  Symbols can be added to data using Conditional Formatting.  On the Home tab, click ‘Conditional Formatting’, then choose which type of 
symbol you would like to use and set your customised rules, if you wish to, in ‘More Rules’.

Charts and Dashboards

Unlike Windows, there is still a menu on Mac, so you can use your mouse or press CTRL + F2 and use arrow keys to open the menus.  Then, you may 
get to many actions and features if you prefer that to the Ribbon or keyboard shortcuts.

Mac Still Has a Menu!
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For example, we have a data set of internal supplier ratings.  We want to 
focus on whether to exclude suppliers with an under-75 average score.  
Therefore, we put a red dot next to any cell matching this condition.  If we 
add a sparkline here, there will be an additional clue when we evaluate 

the criteria.  For instance, Supplier 10 has an average score under 75.  
However, the sparkline shows that the rating exhibits an upward trend, 
which should be taken into consideration before exclusion.

Frequently, we need to include an icon indicator.  As an illustration, imagine we have sales data as below and we need to produce a chart which can 
show the 2018 data with simple icons depicting the changes over the year:

To do this, first, we have to format the cells to indicate the increase / decrease (demonstrated by the vs 2018 (%) column).  In a blank cell, we may 
need to insert the up / down arrow symbol by going to the Insert tab and clicking ‘Symbol’.  For quick navigation, in the Font box, you may also 
choose Arial.  

Then, we can use these symbols in the cell formatting.  Select the cells we need to format (vs 2018 (%) column), and in the ‘Format Cells’ dialog, and 
choose Custom (the last item on the list), where we type:

[Green]▲0.00%;[Red]▼0.00%

In English, this means a positive number will be green and a negative number will be red (both formatted as percentages to two decimal places), 
together with the associated icons.  
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After cell formatting, the data table will now display as follows:

It’s better to create a chart that illustrates this data with the assigned symbol, but that’s for next month…

We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.   
This month we look at the VBA Editor.

Using the ‘View Macros’ option is one way to get to the VBA Editor.  However, it is also accessible from Excel via the ‘Developer’ tab in the Ribbon.  
Under the ‘Code’ category on the ‘Developer’ tab, clicking on the ‘Visual Basic’ button will take us directly into the VBA Editor:

Visual Basics
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Alternatively, ALT + F11 is the keyboard shortcut to enter the Microsoft Visual Basic for Applications editor (known as the “VBA Editor”).

Let’s review the Visual Basic Editor and familiarise ourselves with the different components:

Many of these terms are self-explanatory but let me go through some of them:

	 •	 the Code Window is where procedures appear, i.e. macros that have been recorded and stored are also displayed here.  The code  
		  window is also where we can write code for our macros

	 •	 the Procedure List is visible at the top-right of the Code Window.  From this list, navigation to any procedure in the active module is quick  
		  and easy.  Also notice the view options at the bottom of the screen.  When we have several macros in a module, it can be helpful to view 	
		  them one at a time

	 •	 Full Module View allows us to switch between viewing the ‘Full Module view’ and single procedure view with just a click of a button

	 •	 the Immediate Window is used to debug and evaluate expressions, execute statements, print variable values etc.  It allows us to enter 	
		  expressions to be evaluated or executed by the development language during debugging

	 •	 Project Explorer is where we see the list of all VBA projects that are currently open or loaded.  All open documents, as well as open or  
		  loaded document templates, appear here, regardless of whether they contain macros or not.  They can be easily collapsed or expanded to  
		  view the modules and objects that it contains

	 •	 for modules, the Properties Window is generally used only to edit the module name.  Module naming rules are the same as macro  
		  naming rules – no spaces or special characters and the name must begin with a letter.  However, for some object types (such as  
		  UserForms), the Properties Window becomes extremely important because it's populated with many settings that we can edit directly in  
		  that window, like the height and width of a UserForm or the value to display on a form control.

Continued next month.
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We continue our series on the Excel COM add-in, Power Pivot.  This month, we review the NOT function.

Sometimes we must create custom columns that return with either TRUE or FALSE values.  We may also have to create custom columns that have 
inverse values to another logical column.  For example, if we create a custom column with TRUE or FALSE values, we would create another column 
with the inverse TRUE or FALSE value for each row.

To kick start this example, we are going to revisit the custom columns we created for the Conditional Custom Columns Using IF, OR and ‘||’ article.

We will use the following Table:

After importing the Table into our data model we are going to create a simple custom column that returns with TRUE when Category 1 is ‘Y’ or 
Category 2 is ‘N’ (you can read more about using the ‘||’ delimiter here):

=IF([Category 1]="Y" || [Category 2]="N",TRUE,FALSE)

If we need to create a column with the inverse TRUE or FALSE values, we can use the IF function: 

=IF(Table1[Included]=TRUE,FALSE,TRUE)

Power Pivot Principles
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We can also use the NOT function.

The NOT function uses the following syntax:

=NOT([Calculated Column])

With that in mind, we can create the following calculated column:

=NOT(Table1[Included])

Rather simple, yes?

One important point to note is that the NOT function requires the [Calculated Column] input to have TRUE or FALSE values.  Text values will not be 
accepted by the NOT function, even if they literally say ‘TRUE’ or ‘FALSE’.  

That’s it for this month; more next time.  

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we take a final 
look at an example where we need to translate numbers to letters in multiple columns, this time using the M function List.ReplaceMatchingItems() 
and matching those items using values from another table.

(Yet again) we have the exam results for some children who were 
lucky(!) enough to take their exams when the system was in the middle 
of changing from letters to numbers.  It’s confusing, not least because 
nine [9] is the new top grade, whereas intuitively we might expect one 
[1] to be the highest.  We want to replace the numbers with letters so 
that I can see everything in the same format.  We’ve completed the 

task in the last newsletter articles.  In the first, we did this by using List.
ReplaceMatchingItems(), and last time out, this was performed by 
merging our table of results with a table of numeric to letter equivalents.  
This time, we will be using a combined approach which is designed to be 
more robust. 

Power Query Pointers
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Since the last blog, Liam has been awarded 10 in all the numeric grades (but of course – shame it’s out of 100)!  This will have an impact on how we 
create the list of numeric grades, as we show later.  [That’s a shame – this appears to be Kathryn’s last article – Ed.]

We’ll begin by creating a query ‘From Table’ in the ‘Get & Transform’ section of the ‘Data” tab.

We want to translate all the values at the same time in all numeric 
columns, creating new columns.  One way to do this is to use List() M 
functionality.  Let’s begin by merging the columns we need to translate, 
namely English Language, English Literature and Mathematics.  This 

would work equally well if we were to merge all the columns and if we 
had less stable data, i.e. other subjects were soon to move to numeric 
grades, then this approach would be better.  There are also ways to allow 
for a variable number of columns, but we will save this for another time.
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Let’s decide to use a comma delimiter to help us convert our data back later.

Now this is where we used Text.ToList to convert our column to lists previously.  However, as we’ll show below, there is a problem with this.

This gives us a column of lists that we may manipulate.
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However, if we look at how the list is constructed,

we can see that each character has been given a separate list entry.  If instead we look at Liam’s list of grades,

this shows that any translation would replace the one [1] not the 10, so that’s not what we want.  There is another function that works better in 
these circumstances:

Text.Split(string as text, separator as text) as list

This returns a list containing parts of a string that are delimited by a separator text value.

Therefore, we add a new custom column:
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The M formula used is:

= Text.Split([Merged],",")

We have a list of each of the grades this time, so we are ready to move to the next step.  Instead of specifying what to replace in a manual list, we’re 
going to convert our grade equivalents table into a list that we may use.

We found when we were carrying out this task it was easiest if we made sure that the columns in our Excel table were set to ‘Text’.  Having created a 
query from the grade equivalents table, we need to create a column that stores each pair of rows as a list.  To do this, we use the Table.AddColumn() 
function:

Table.AddColumn(table as table, newColumnName as text, columnGenerator as function, optional 
columnType as nullable type) as table

This adds a column named newColumnName to a table.  

If we add the new column by defining a list, then we may create a column of lists:
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We convert the remaining column to a list so that we now have a list of lists called ‘Equivalents’.  We save this as ‘Connection Only’.  We can now go 
back to our first query and use a List() function to transform our data.  The one we are going to use is 

List.ReplaceMatchingItems(list as list, replacements as any, optional equationCriteria as any) as list

This replaces occurrences of existing values in the list with new values using the provided equationCriteria.  Old and new values are provided by the 
replacements parameters. 

The M functionality we have used is

= List.ReplaceMatchingItems([List_of_Grades], Equivalents)

This replaces any entries in my merged column that are in the first item in the list in ‘Equivalents’ with the second item in the list.  Therefore, any 
numerical grades should be translated to the corresponding letter grade.

The formula we have used is

= Table.AddColumn(Source, "Equivalents_list", each ( { [Number Grade], [Equivalent Letter Grade] } ))

This creates a list of pairs of number grades and their equivalent letter grade.  We delete the other columns to only leave Equivalents_list:
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Judging by the new list of Liam’s grades, it’s looking promising!  Now we will extract the list:

We’ll choose to use a comma delimiter here, as Text.Split has not included the comma delimiter we used earlier.

On the ‘Transform’ tab, we can choose to split the column.
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We click ‘OK’ to create three new columns:

We can now remove the other list and the temporary column we used to merge the grades.  We’ll also rename our new columns.

We can now see what the letter grade is for English and Maths.  Yay!

More anon.

Aside from all the above on Fabric and Copilot in Power BI, there is the usual volume of updates this month, including ‘DAX Query view’, semantic 
model scale-out and Advanced Filtering for Paginated Reports.  

The full list is as follows:

Reporting

	 •	 Button slicer in Preview

	 •	 Reference labels in Preview

	 •	 Enhance your Q&A visual with suggested synonyms from 	 	
	 	 Copilot in Preview

	 •	 On-object Interaction updates:

	 	 	 ○	  Always open in new pane’ setting
	 	 	 ○	  Resizing the data flyout
	 	 	 ○	  Table’s ‘Add’ button returns
	 	 	 ○	  New On-object default coming soon	

	 •	 Azure Maps visual now aggregates multiple data points at the 	
	 	 same location

	 •	 Narrative visual with Copilot in Preview

Modelling

	 •	 Datasets renamed to semantic models

	 •	 DAX query view to write and run DAX queries on your model 	
	 	 in Preview

	 •	 Edit your data model in the Power BI Service – updates:

	 	 	 ○	  Mark as a date table
	 	 	 ○	  Rename and delete tables and columns

Power BI Updates
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Data connectivity

	 •	 Azure Resource Graph (new connector)

	 •	 Profisee (connector update)

	 •	 Bloomberg Enterprise Data and Analytics (connector update)

	 •	 Dremio (connecaaator update)

	 •	 Celonis (connector update)

Service

	 •	 Explore in Preview

	 •	 Copilot for Power BI in Microsoft Fabric in Preview

	 •	 OneLake integration for Import-mode semantic models in 	 	
	 	 Preview  

	 •	 RLS / OLS security and stored credentials for Direct Lake 	 	
	 	 semantic models in Preview

	 •	 Sharable cloud connections for semantic models now 	 	
	 	 Generally Available

	 •	 Semantic model scale-out now Generally Available

	 •	 Show visuals as tables in Preview

	 •	 Advanced Filtering for paginated reports

Visualisations

	 •	 New visuals in AppSource

	 •	 Zebra BI Tables 6.6: introducing text columns

	 •	 Funnel Chart by Powerviz

	 •	 Create interactive timelines with full control

Other

	 •	 Enhanced accessibility in paginated reports authored in Report 	
	 	 Builder 

	 •	 Skill up on Fabric with the Microsoft Learn Cloud Skills 	
	 	 Challenge

	 •	 Dynamic dataset binding for paginated reports.

Let’s look at each in turn.

This update introduces the Button slicer, an oft-requested tool for slicing data.  Apparently, this is just the first step in a five-stage journey that will 
replace the old tile slicer with a better, more flexible alternative.

There are quite a few upgrades and enhancements in the new Button slicer:

	 •	 you may now customise the shape and appearance of your design with more control to modify the corner radius

	 •	 with an adjustable grid layout, you may now divide your design into rows and columns, and even use pixels to customise card spacing

	 •	 when grid layouts have more buttons than rows and columns, use overflow styles, and choose Pagination or Continuous scrolling with 	
		  vertical or horizontal direction

	 •	 just like the new card visual, the Button slicer simplifies alignment and format properties, and the Label feature will spotlight crucial  
		  information from within your buttons

	 •	 image control allows you to infuse buttons with ivvmages such as URL images

	 •	 interactive states make designs more engaging with options including on hover and on press 

	 •	 there are new formatting settings to make the slicer more versatile

	 •	 ‘Single select’ has been updated with a ‘Force Selection’ toggle and a new ‘Select All’ option

	 •	 the new multi-select feature allows greater flexibility

	 •	 a new ToolTips experience is available for the new Button slicer, as it now supports both default and report page ToolTips.

Button slicer in Preview
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With this Preview update, the new Button slicer feature has been toggled ON by default and is found in one of three places:

	 1.	 the Visual gallery on the Ribbon

	 2.	 by selecting ‘Build a visual’ after right-clicking on the canvas, and then choosing the new slicer

	 3.	 by selecting new slicer from the on-object dialog. 

You may also toggle this feature Preview on or off by looking under Options -> Preview features -> New button slicer.

As mentioned earlier, this is only the first stage on the new slicer roadmap…

Reference labels is a versatile tool employed for adding custom labels to new cards, providing relevant information, comparisons, key metrics, 
benchmarks, goals and more.  This represents the second step in Microsoft’s five-stage new card visual journey.

Reference labels in Preview
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With Reference labels, end users will have access to the following features:

	 •	 not only can you Reference labels to your card visual, but you even add multiple data fields to your Reference labels

	 •	 with three main components, namely Title, Value and Detail, you may also choose custom content using a different data field or measure 	
		  and apply various styles to both Title and Value

	 •	 extra context is available for the Detail component, showing data from a single data field well, but is also customisable with styles and 	
		  colours

	 •	 with an active Divider, Reference labels have their own area where you can modify the divider line and use colour to differentiate callout 	
		  and Reference labels

	 •	 Reference labels may have a horizontal or vertical layout and can have custom spacing and padding too.

With this Preview update, the new ‘Reference labels’ feature has been toggled ON by default for convenience and is found in one of three ways:

	 1.	  from the Visual gallery on the Ribbon

	 2.	 by selecting ‘Build a visual’ after right-clicking on the canvas, and then choosing the new slicer

	 3.	 by selecting new slicer from the on-object dialog. 

You may also toggle this feature preview on or off by looking under Options -> Preview features -> Reference labels.

The Q&A visual allows you to ask questions about your data and get answers in the form of visual.  It provides any report viewer with an intuitive 
means to explore their data without requiring deeper knowledge of the model or report authoring.  I know; I have relied upon it for years!

Enhance your Q&A visual with suggested synonyms from Copilot in Preview
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Presently, the Q&A visual doesn’t rely upon generative AI to function.  
The Q&A engine processes your natural language input all inside Power 
BI algorithmically using a variety of linguistic principles, associating 
words and phrases you use with data in your model.  This makes it good 
at answering precise questions about your data, but it may not be able 
to associate everything you input with data in the model. 

To help authors ensure that the Q&A visual provides consistent 
and accurate answers based upon the unique language their report 
consumers actually use, Microsoft has introduced Q&A setup tools with 
an emphasis on providing Q&A with synonyms for column and table 
names in the model.  This way, authors may explicitly define different 
ways people might refer to their data, and users will always receive the 
correct answers when they ask similar questions in the future.

Power BI recognises two types of synonyms: approved synonyms and suggestions: 

	 •	 Approved synonyms either come directly from the names of fields themselves or are explicitly added by the author.  When you use an 	
		  approved synonym in your Q&A input, it will be treated just as though you used the name of the field and the association will be 	
		  presented with high confidence, signified by a solid blue underline

	 •	 Suggested terms are words Power BI thinks are likely to refer to their corresponding name.  They come from a variety of sources – 	
		  synonyms from the Office thesaurus show up by default, but you can also connect to your organisation’s collection of approved terms  
		  and add those to your suggestions as well.  Suggestions will still be used by Q&A, but with lower priority than approved synonyms, and 	
		  the lower confidence will be signalled in the results with a dotted orange underline.  In the Q&A setup menu, suggestions may be added 	
		  to the approved synonyms list or removed entirely.

Managing synonyms is therefore an important part of improving the 
quality of the Q&A experience.  However, coming up with synonyms for 
every data entity in your model can be mentally laborious and physically 
time-consuming.  Copilot for Power BI streamlines this process by 
generating some for you.

If you have Copilot enabled, there are a few ways for you to get 
suggestions from Copilot.  However, before you being you will have to 
enable the feature in Power BI Desktop in File -> Options -> Preview 
features -> Improve Q&A with Copilot.
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Then, you might be prompted to add synonyms with Copilot via a banner that shows up the first time you make a Q&A visual or open the Q&A setup 
menu:

You’ll also be able to get Copilot suggested synonyms via the Q&A setup menu.  You can turn on Copilot as a source in the suggestion settings menu 
in the Synonyms tab, then click ‘apply to get synonyms’.  Alternatively, if Copilot is already enabled as a source, you can click the Refresh button next 
to the suggestion settings dropdown.
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After you have entered / received these suggestions, you might be prompted to review them.  You’ll find the new synonyms in the suggestions 
column in the synonyms page of the Q&A setup menu:

Copilot-suggested synonyms will function just like any other suggested 
synonyms.  This means that they may be used by Q&A as a fallback when 
trying to determine what data fields a natural language input may refer 
to.  You should carefully review them in the Suggestions column of the 
Q&A visual, remove the synonyms which are inaccurate and approve the 
ones which best fit the data.

Please keep in mind that as Microsoft scales out Copilot, you might run 
into throttling, which may cause Copilot to return incomplete results if 
you send too many requests in a short period of time.  If that happens, 
you should wait a while and try again.  Copilot may also not return results 
for terms for which it cannot generate synonyms or when its results are 
deemed inappropriate by Microsoft’s content filter.  That fxxxing sxxxs.

This month’s updates introduce the ability to configure your pane switcher to stack panes instead of swap them.  If you preferred the behaviour from 
before, where panes opened side-by-side by default, you can now configure this setting by checking the new option for ‘always open in new pane’ 
from either the Options menu or the View tab on the Ribbon.

To achieve the stacked behaviour of panes as before:

Turn on the new option within the Options menu:

‘ALWAYS OPEN IN NEW PANE’ SETTING

On-object Interaction updates
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Or else select the new option from the View tab on the Ribbon:

The ability to resize the data flyout (second flyout) from the Build button when working with long field names has also been added this month.

The Table visual has the add button again.  Originally, Microsoft had to 
remove the Add button from the Table visual type as currently the only 
chart element to add from this menu was the title that does not have a 
default value.  This added confusion to the experience because simply 
turning on the title did not appear to have changed anything in the visual 

and users had to go to the Format pane to type in their visual title.  In the 
most recent update, Microsoft shipped placeholder text which allowed 
Power BI to bring back the Add button for Tables.  Now, when turning on 
title, a placeholder will appear to type directly onto the visual.

Microsoft has noted that there may be cases where the resize handles appears to the left of the data flyout if there is not enough space to expand 
on the right side.  They state that this bug is known, and that they are working on a fix.  As a workaround in these cases, you can move the visual to 
left temporarily on the canvas to resize the data flyout.

RESIZING THE DATA FLYOUT

TABLE’S ‘ADD’ BUTTON RETURNS
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With this month’s addition of the new ‘always open in new pane’ setting, the next update Microsoft be able to introduce is a new default setup that 
feels closer to the previous “classic” look.  With this new default, you will be able to preset the following options with just one click:

	 •	 move the ‘build a visual’ menu to the pane switcher by default

	 •	 show both build and data panes expanded by default

	 •	 Format pane in the pane switcher by default

	 •	 ‘Always open in new pane set to on, thereby stacking panes by default

	 •	 collapse panes to the pane switcher instead of close ‘X’ by default.

Previously, when you had multiple data points with the same latitude and 
longitude field values, those points would be plotted separately, leaving 
them drawn one over the other at the same location.  This could lead 
to some unclear data visualisations.  For example, grouping the points 

by category using a legend field might leave just one category visible 
per location due to the overlap.  This behaviour was also different from 
visualising those points using location names, which would aggregate 
the points together.

With this release, Azure Maps now aggregates points with the same latitude and longitude values in the same way that it does with location names, 
allowing you to see them as one bubble.  These aggregated points can then be filtered or grouped as you would normally.

NEW ON-OBJECT DEFAULT SETUP COMING SOON

Azure Maps visual now aggregates multiple data points at the same location
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Copilot’s unique ability to summarise data has now been exploited 
to the rebranded ‘Narrative with Copilot’ visual – formerly ‘Smart 
Narratives’.  This visual allows you to use Copilot to summarise data 
across your report or even specific pages or visuals you choose.  Power 

BI offers suggested prompts to get authors started, such as “Give me 
an executive summary”, “Answer likely questions from leadership” and 
“created a bulleted list of insights”.  Users can also type in their own 
custom prompts and questions that return summaries about their data.

Narrative visual with Copilot in Preview
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Users have the ability to choose whether they want to summarise over 
the entire report, select pages or even specific visuals across their report, 
giving them flexibility in what their summary looks like.  Users will also 
see references for each portion of the summary that align to visuals on 
the various pages on the report, from which the summary lines were 
generated, making it easy to validate the summary’s accuracy and tie it 
back to the data.

The summary can be updated as thwe data is sliced and diced, so end 
users may interact with it, without editing the prompts themselves.  This 
narrative visual with Copilot makes it faster to communicate insights 
about the data that matters to you.  The visual is available in the Service 
and in Power BI Desktop.

Datasets are being renamed “semantic models” in Power BI and Fabric.  
This might seem like a semantic point [groan – Ed.] but it is necessary for 
disambiguation from other Fabric items and will make the product clearer 
and more usable.  You will see this change in the most prominent user 
interface (UI) elements and Microsoft has stated that the documentation 
is presently being updated. 

Application Programming Interfaces (APIs) are not currently affected 

as Microsoft will progressively roll out further changes.  The timing of 
this change is driven by the upcoming General Availability of Fabric and 
aligns with the rename for Machine Learning (ML) models.  It reflects 
the immense progress that Power BI datasets have made in becoming 
an enterprise-grade semantic modelling technology.  The semantic 
model name will help drive awareness of the new powerful capabilities 
provided.

Datasets renamed to semantic models
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DAX query view to write and run DAX queries on your model in Preview

The ‘DAX Query view’ is a fourth view in Power BI Desktop which 
allows you utilise the powerful DAX query language using EVALUATE 
to discover, analyse and see the data in your semantic model.  Similar 
to the Explore feature in Power BI Service (see below), model authors 
may quickly validate data and measures in their semantic model without 

having to build a visual, publish or use an additional tool.  Changes made 
to measures may be updated back to the semantic model.  DAX queries 
are different from DAX expressions used to create model items such as 
measures, calculated columns and calculated tables, and are more like 
SQL queries returning data in a table.

This powerful way to interact with your data model is now available in the new ‘DAX query view’:

	 •	 Quick queries can generate DAX queries for you in the Data pane context menu of tables, columns or measures, giving you a head start by 	
		  generating a DAX query to preview data or show summary statistics.  You may use DAX queries to help you understand the data without  
		  creating visuals and for DirectQuery you no longer must go back to Power Query to see some sample data

	 •	 Quick queries may be used to obtain the DAX expression of all, some or a specific measure in a generated DAX query.  It provides the  
		  DEFINE block with the measure’s DAX expression and an EVALUATE block to see the measure’s output.  You may then add to the DAX  
		  query with any additional group by columns
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	 •	 ‘Update the model options’ will be available to you with any DAX query updates to measures in DAX query’s DEFINE block
	 •	 measures that reference other measures can now be seen on the same screen and updated together.  You may preview the output of 	
	 	 your changes and then also update the model when read

	 •	 Report view’s ‘Performance Analyzer’ already lets you copy the visual DAX query.  Now, you no longer need to take that DAX query and 	
	 	 use another tool to view and run it: simply run it in ‘DAX query view’ instead
	 •	 all these features are now in a bigger DAX query editor similar to VS Code, including more keyboard shortcuts and the ability to improve 	
	 	 readability by formatting any DAX query.

Microsoft plans to continue to add functionality to the ‘DAX query view’: they have previously shown a visual demonstration with a ‘DAX query view 
Copilot’, which will be coming soon. You may get started today by turning on this public Preview feature in Options -> Preview features.

The new data model editing in the Service feature was released to preview in April.  Since then, Microsoft has been busy.  Below are the improvements 
in this month’s set of updates:

Within the Service, you can now mark a table in your data model as a 
date table.  Marking a date table in your model allows you to use this 
table for various date-related elements including visuals, tables, quick 

measures and more, with full Time Intelligence support.  To set a date 
table in the Service, right-click on the desired table and choose ‘Mark as 
date table => Mark as date table’ in the menu that appears.

Edit your data model in the Power BI Service – updates

MARK AS A DATE TABLE
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Next, specify the date column by selecting it from the dropdown menu within the ‘Mark as date table’ dialog.  Power BI will then perform validations 
on the selected column and its data to ensure it adheres to the ‘date’ data type and contains only unique values.

Within the Service the following functionality is now supported:

	 •	 Renaming and deleting any table

	 •	 Renaming and deleting any column.

You may now empower your data insights with the Power BI data connector for Azure Resource Graph.  Now, you can transform your Azure Resource 
Graph queries into visualisations within Power BI.  

Profisee’s Power BI Connector Version 3.0 exposes new information 
around data quality, enhancing analytics on data quality improvements for 
data managed in Profisee with detailed information regarding validation 
issues flagged within their data.  Additionally, the data types have been 

refined streamlining the experience for users using the Profisee Connector 
to load data from Profisee to Microsoft Fabric using Data Factory Gen 2 
Data Flows.

This version of the Bloomberg Data and Analytics connector for Power BI includes changes to support underlying infrastructure updates and back-
end performance enhancements.  All user-facing features remain unchanged.

The Dremio connectors have been updated to support additional optional values and parameters.

The Celonis EMS connector has been updated with minor changes.

RENAME AND DELETE TABLES AND COLUMNS

Azure Resource Graph (new connector)

Profisee (connector update)

Bloomberg Enterprise Data and Analytics (connector update)

Dremio (connector update)

Celonis (connector update)

Explore in Preview
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Within Power BI, many times you need to perform ad hoc exploration 
of your data.  This could be as an analyst who just been provided with 
access to a new dataset or data source and wants to spend time learning 
about the data before building a report off it.  Alternatively, you may be 
a business user who needs to answer a specific question using the data 
to include in a PowerPoint presentation, but the report you are using 
doesn’t answer the exact question you have.  Creating a new report from 
scratch in these cases is a large hurdle, just to get a quick answer or 
screenshot for a deck.

This is where the public Preview of the new Explore feature comes 
in, where users have a lightweight and focused experience to explore 
their data.  Similar to exporting and building a PivotTable in Excel, now, 
directly within Power BI users may quickly launch Explore to begin 
creating a matrix / visual pair to get the answers they need without all 
the distractions and extra complexity of reports.

Simply find a dataset or report you’d like to explore:

Begin building your matrix / visual pair to get to the answers you need:

And, if you’d like to return to your work save it as an exploration:

Easy!
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And so to the public Preview of Copilot in Microsoft Fabric, including the 
experience for Power BI which helps you quickly get started by helping 
you to create reports in the Power BI web experience.  This update has 
also added Copilot’s ability to summarise data to the ‘Smart Narrative’ 
visual, now rebranded as the ‘Narrative with Copilot’ visual (see above).  

The visual is available in the Power BI Service and in Power BI Desktop.  
Lastly in Desktop, the Power BI team has added the ability to generate 
synonyms for their fields, measures and tables using Copilot.  To use 
Copilot, you’ll need access to a workspace that has a P1 or higher or an 
F64 or higher capacity.

This month also witnesses the public Preview of Microsoft OneLake integration for import models.  With the click of a mouse button, you can enable 
OneLake integration and automatically write data imported into your semantic models to delta tables in OneLake, as depicted in the following diagram:

The data is instantaneously and concurrently accessible through 
these delta tables.  Data scientists, DBAs, app developers, data 
engineers, citizen developers and any other type of data consumer 
can now get seamless access to the same data that drives your 
business intelligence and financial reports.  You can include these 
delta tables in your Lakehouses and Synapse Data Warehouses via 
shortcuts so that your users can use T-SQL, Python, Scala, PySpark, 
Spark SQL, R and no-code / low-code solutions to query the data. 
 

OneLake integration can even help you if you don’t plan to query the 
data.  Perhaps you only want to export the data to backup files.  Thanks 
to OneLake integration, this is very straightforward now.  Ensure that 
your import-mode semantic model is hosted in a workspace on a 
Premium or Fabric capacity and that the large dataset storage format 
is enabled.  Then, enable OneLake integration and perform a manual or 
scheduled data refresh operation.  That’s it!  The semantic model writes 
the imported data to the delta tables as part of the refresh operation.  
Exporting import-mode tables has never been easier.  The delta tables 
are kept up to date without requiring any ETL pipelines copying data.

Copilot for Power BI in Microsoft Fabric in Preview

OneLake integration for Import-mode semantic models in Preview  
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Of course, you can also export the data programmatically via Tabular Object Model (TOM) and Tabular Model Scripting Language (TMSL) if you can 
access your semantic model through XMLA in read-write mode.  For example, you can open SQL Server Management Studio (SSMS) and run the 
following TMSL command:

{

"export": {

"layout": "delta",

"type": "full",

"objects": [

{

"database": "<Name of your database>"

}

]

}

}

If you have installed the latest version of OneLake File Explorer, you can 
conveniently verify the success of the export process by using Windows 
File Explorer.  In OneLake File Explorer, right-click on the workspace 
folder and select Sync from OneLake.  Then, in the workspace folder, 
look for a subfolder with a name that matches your semantic model 
and that ends with .SemanticModel, as in the screenshot above.  In this 
semantic model folder, every import-mode table has a subfolder that 
contains the delta table’s parquet files and delta log.

You don’t need to know these file system details if you add shortcuts for 
your semantic model’s delta tables to other workloads in Fabric, such 
as lakehouses etc.  Simply launch the Shortcut Wizard UI, pick Microsoft 
OneLake, select the semantic model, and then pick the tables you want 
to include, as in the screenshots below, and that’s it.  You are ready to 
read and query the tables using your usual data tools and APIs.

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

That’s it.  Now you can use Direct Lake mode to read delta tables directly 
from OneLake and write delta tables thanks to OneLake integration.  
Fabric is assisting how customers may build their BI solutions for faster 
performance at big-data scale while at the same time reducing Total Cost 

of Ownership (TCO) and infrastructure complexity.  For example, you no 
longer need an entire portfolio of homegrown ETL solutions to get data 
volumes of any size in and out of semantic models. 

It keeps going this month, doesn’t it?  Up next is the public Preview of 
the Row Level Security / Object Level Security (RLS / OLS) and stored 
credentials for Direct Lake semantic models.  RLS / OLS is a Power BI 
feature that enables you to define row-level and object-level access rules 
in a semantic model, so that different users can see different subsets of 
the data based on their roles and permissions.  Stored credentials help 

reduce configuration complexity and are strongly recommended when 
using RLS / OLS with Direct Lake semantic models. 

The following screenshot shows how you can add users to RLS roles in 
a Direct Lake model by using the Web modelling experience.  The web 
modelling security roles dialog will be fully deployed in the coming days 
or weeks. 

There is (almost) nothing special for RLS / OLS in Direct Lake models.  
You can define roles and assign users as for any other semantic model 
type.  However, do keep in mind that by default Direct Lake models 
use single sign-on (SSO) authentication to the underlying data source.  
Using RLS / OLS in conjunction with SSO can be challenging because 

it involves multiple authorisation layers — RLS / OLS in the semantic 
model and user authorisation at the data source.  For example, if you 
wanted to authorise a new user, you would have to add that new user to 
appropriate RLS roles and ensure that the user has access permissions to 
the underlying delta tables in the lakehouse or data warehouse.

RLS / OLS security and stored credentials for Direct Lake semantic models in Preview
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Managing user authorisation at multiple layers adds complexity and 
friction.  That’s why Power BI has introduced support for stored 
credentials with Direct Lake semantic models.  Your semantic models 
can now access the delta tables at the source with a single, fixed identity 
on behalf of the users instead of delegating the actual user identities 
via SSO.  When adding new users to an RLS role, you are effectively 

authorising them to use the fixed identity.  Because this approach avoids 
SSO-related complexity and friction, it is strongly recommended that you 
switch to a fixed identity whenever you add RLS / OLS to a Direct Lake 
model.  Switching to a fixed identity is as easy as binding the Direct Lake 
model to a Shareable Cloud Connection (SCC) that has SSO disabled.  

Here are the steps to configure a Direct Lake model with a fixed identity:

	 •	 display the settings of the Direct Lake model and expand the Gateway and cloud connections section.  Note that your Direct Lake model 	
		  has a SQL Server data source pointing to a lakehouse or data warehouse in Fabric

	 •	 under Maps to, open the listbox, and click on Create a connection.  This will pull you to the connections management page with the new  
		  connection form opened and prepopulated with the data source information

	 •	 select ‘OAuth 2.0’ or ‘Service Principal’ as the authentication method and provide the credentials of the fixed identity you want to use

	 •	 make sure you disable to checkbox labelled ‘Use SSO via Azure AD for DirectQuery queries’, as in the below screenshot

	 •	 configure any other parameters as needed and then click Create.  This pulls you back to the Direct Lake model settings page.  Verify that  
		  the data source is now associated with the non-SSO cloud connection.

The ability to set up stored credentials is available right now.  The RLS editor for Direct Lake datasets in the web modelling experience is being 
deployed and will be visible in the coming days or weeks.
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Along with the General Availability (GA) of shareable cloud connections 
(SCC), SCC support for semantic models and paginated reports has been 
announced as GA as well.  Now, you may use this modern connection 
type in conjunction with your production semantic models and paginated 
reports to access cloud data sources and centralize cloud connection 
management. 

In enterprise organisations, centralising cloud connection management 
in addition to data gateway management can help to lower the overhead 
of maintaining data connections and credentials.  SCCs let you securely 

share access to cloud data sources through an access-control list.  The 
credentials are protected and cannot be retrieved from the SCCs, 
but Power BI users with at least ‘Use permissions’ may connect their 
semantic models and paginated reports to the cloud data sources 
through these SCCs.  You can also create multiple connections to the 
same data source, which is particularly useful if you want to use different 
connection settings, such as different credentials, privacy settings or 
single-sign-on settings for different semantic models, paginated reports 
and other artifacts.

The semantic model scale-out is now generally available (GA).  Large-scale 
production solutions will benefit from high user concurrency, as Power 
BI automatically scales out read-only replicas to ensure performance 
doesn’t slow down when lots of users are using the system at the same 
time.  Of course, automatic scale out works for Direct Lake semantic 

models.  Additionally, Import-mode semantic models will benefit from 
refresh isolation, ensuring business users are unaffected by resource-
intensive refresh operations and continue to enjoy enable smart, quick 
queries for interactive analysis.

Leveraging Power BI’s previous accessibility improvements to Table and 
Matrix visualisations, the Power BI team is now introducing a new view 
mode called ‘Show visuals as tables’, which displays report visuals in a 
tabular format with a single action.  Some users may prefer to consume 
data in a text-based or tabular format depending on their different 
learning styles and usage of assistive technologies.  This provides a 
supplemental format for visuals that allows users to display the data in 
the way that best meets their needs.

This new view mode is similar to how ‘Show as a table’ displays underlying 
data for individual visuals today.  ‘Show visuals as tables’ will display the 
underlying data for visuals for all pages in the current report, with the 
added functionality of interaction and cross-filtering capabilities.

To activate this view mode, navigate to the view dropdown menu and 
select ‘Show visuals as tables’:

Semantic-model scale-out is the last of the key features to make Microsoft 
Fabric and Power BI a superset of Azure Analysis Services (AAS) and is 
superior in Fabric compared to its equivalent in AAS.  Unlike AAS, scale 
out takes place based on live user demand, and adjusts automatically to 

changes in usage patterns.  AAS, on the other hand, requires detailed 
analysis to determine peak usage times, creation of automation scripts 
and ongoing monitoring to ensure optimum set up.  Additionally, cost in 
AAS increases linearly per replica, unlike Fabric that is usage based.

Here’s a quick summary of the benefits semantic model scale-out can provide to your reports, dashboards and other BI solutions:

	 •	 increased query throughput: Power BI can automatically scale read-only replicas when query volume increases and fluctuates

	 •	 refresh isolation: refresh and write operations on the read-write replica do not impact the query performance on read-only replicas

	 •	 more flexibility for advanced data refresh scenarios: as a side-benefit of refresh isolation, you can now perform advanced refresh 	
		  operations on the read-write replica without impacting the read-only replicas.  Simply disable automatic replica synchronisation, then 	
		  refresh, refresh, refresh until the read-write replica is fully updated, and then synchronise the read-replicas manually.

Sharable cloud connections for semantic models now Generally Available

Semantic model scale-out now Generally Available

Show visuals as Tables in Preview
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To revert, select ‘Show original visuals’:

Alternatively, you may simply use the keyboard shortcut CTRL + SHIFT + F11 to toggle between the two views.

You can now use ‘Advanced Filtering’ whilst authoring paginated reports on the Service.  This allows you to define conditions such as contains or does 
not contain, is not equal or is equal, or else to a specific value.

There is just the one to report this month:

	 •		 Apex Gantt chart.

With Zebra BI Tables 6.6, you can add multiple text columns inside the table.  Using this feature, you can bridge the gap in data visualization by having 
relevant information side by side in the table / matrix custom visual for Power BI:

Advanced Filtering for paginated reports

New visuals in AppSource

Zebra BI Tables 6.6: introducing text columns

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

With this feature, you can now display multiple text columns in a tabular way, which leads to a better understanding of the data when displaying 
more attributes of the same Category.  Additionally, there is no need to apply any complex DAX functions.  Simply add additional text columns into 
the ‘Values’ placeholder.

Some popular use cases include:

	 •	 in one-to-one mapping, you usually need to add additional information next to the descriptive column to ensure data accuracy, 		
		  consistency and ease of reference:

			   ○	 Product ID: Product name
			   ○	 Product ID: SKU: Shipping / Order ID
			   ○	 Job ID: Job title

	 •	 The new feature also works in cases with one-to-many mapping, e.g.

			   ○	 Customer: Sales representatives because the same person can represent multiple customers.

You can also add multiple text columns when presenting data in a hierarchical table or using cross-tables for quarterly performance.

The Funnel Chart by Powerviz is their take on the Funnel chart.  It has four [4] chart types in one visual, including a Pyramid chart.  The Power BI-
certified visual is useful for tracking progress through different stages.  It may also group data with legends for detailed insights.

Key features include:

	 •	 Funnel settings: multiple display types are available, including vertical and horizontal orientation

	 •	 Data colours: offers seven [7] schemes and 30+ colour palettes

	 •	 Labels: select from multiple display styles with a custom label option included

	 •	 Conversion rate: in a single click, measure the percentage of top and bottom stages to identify bottlenecks

	 •	 Fill patterns: highlight stages with custom or pre-filled patterns

	 •	 Conditional formatting: create rules based upon measure or category rules.

Many other features included are ranking, annotation, grid view, show condition and accessibility support.

Business use cases include:

	 •	 Sales funnel analysis: track sales stages
	 •	 Marketing campaigns: assess lead generation and conversion rates
	 •	 User onboarding: monitor steps to product adoption.

	 •	 Website traffic: visualise visitor drop-offs.

Funnel Chart by Powerviz
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Drill Down Timeline PRO allows you to create timelines with a date / time hierarchy.  You may click directly on the chart to drill down to examine 
specific periods in detail.  You can combine multiple series and choose between multiple chart types (line, column and area). 

Create interactive timelines with full control
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Main features include:

	 •	 on-chart interactions: click on chart to drill down to months, days, hours or milliseconds

	 •	 customise up to 25 series

	 •	 DAX measure support

	 •	 apply conditional formatting

	 •	 use series defaults and value labels defaults to customise multiple series

	 •	 static and dynamic thresholds: set up to four [4] thresholds to demonstrate targets

	 •	 full customisation: colours, gradients, backgrounds, fonts and more

	 •	 touch device friendly: explore data on any device (not sure that includes remote controls, microwaves and Rubik’s cubes…).

Popular use cases include:

	 •	 Banking and Finance: stock exchange indices, capital ratios, transaction volumes

	 •	 Sales and Marketing: web traffic, audience reach, sales revenue

	 •	 Information Technologies: network traffic, response times, syslog and error trends

	 •	 Manufacturing: quality metrics, uptime and downtime, production output and cost.

The StructureTypeOverwrite property has been added to the .rdl model.  You can use it to improve accessibility for paginated reports in Microsoft 
Report Builder and Power BI Report Builder.  You can then publish these reports to the Power BI Service.

Enhanced accessibility in paginated reports authored in Report Builder 
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Microsoft has announced the Microsoft Ignite: Microsoft Fabric 
Challenge as part of the Microsoft Learn Cloud Skills Challenge.  You can 
skill up for in-demand tech scenarios and enter to win a VIP pass to the 
next Microsoft Ignite.  The challenge is on until Monday 15 January 2024.

In this challenge, you will learn how to connect to data, ingest it with Data 
Factory and notebooks, store it in the lakehouse or data warehouse, and 

create Power BI reports to turn your data into competitive advantage.

The challenge will help you prepare for the Microsoft Certified: Fabric 
Analytics Engineer Associate certification and new Microsoft Applied 
Skills credentials covering the lakehouse and data warehouse scenarios, 
which are coming in the next few months.

You can now use dynamic binding to maintain a single template of an RDL report that can be connected to multiple datasets across workspaces, 
instead of copying and maintaining hundreds of report duplicates.  You don’t need to create copies of the same report with a different dataset.   
You can bind datasets dynamically to a paginated report or a paginated report visual.

More next month!

There is a new ‘Automate Work’ button 
in Excel for the web (if only real life were 
like this), powered by Power Automate, 
making it easier to automate tasks and run 
processes efficiently from anywhere.  The 
new ‘Automate Work’ button replaces the 
‘Automate a Task’ button, extending Power 
Automate’s capabilities to Excel for the web 
by providing access to pre-built templates 
and allowing users to build workflows 
quickly and easily.

For example, you can automatically capture 
customer feedback from emails and store 
it in an Excel for the web worksheet using 
the ‘Monitor incoming emails to an alias 
in an Excel worksheet’ template.  With 
this template, businesses can keep track 
of customer feedback in one centralised 
location, making it easy to respond to 
customer needs and improve customer 
satisfaction.

Skill up on Fabric with the Microsoft Learn Cloud Skills Challenge

Dynamic dataset binding for paginated reports

‘Automate Work’ button 

This month sees several new features rolling out across Excel for the 
web, Windows and Mac.  The Automate Work button, Formula Authoring 
Enhancements and ‘Queries and Connection’ pane are now available 
in Excel for the web.  Furthermore, web connector enhancements 

and ‘Optimized Narrator Screen Announcements’ have started rolling 
out to users of Excel for Windows.  Finally, checkboxes in cells and the 
ability to control your data conversions come to Insider users [on Excel  
for Windows].

You can check out the full list here:

Excel for the web

	 •	 ‘Automate Work’ button 

	 •	 Formula authoring enhancements

	 •	 ‘Queries and Connections’ Pane

Excel for Windows

	 •	 Checkboxes in cells (Insiders)

	 •	 Control data conversions

	 •	 Web connector enhancements 

	 •	 Optimising Screen Narrator Announcements

Excel for Mac

	 •	 Control data conversions.

Let’s get started.

New Features for Excel
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The new ‘Automate Work’ button is currently available in Excel for the web for users that have a commercial or EDU license that gives access to the 
Microsoft 365 office desktop apps (e.g. Office 365 E3 and E5 licenses) only.

It should be noted that if you do not have the Automate tab in Excel for the web, your administrator may have disabled the feature.

There is a new set of capabilities in Excel for the web that help make creating and correcting formulae easier, enabling you to work on your 
spreadsheets more effectively and confidently.  They are detailed below.  

The ‘Insert Function’ dialog simplifies the process of building complex 
formulae, as it provides a user-friendly interface to help you select 
the right function and its arguments.  Now, you may quickly look up 
a function or browse through categories to find what you need.  Each 

function comes with a description and expected arguments, and you get 
a preview of each argument's value and the complete formula.  You may 
access the dialog from the Formulas tab and then click the ‘Insert Function’ 
button or otherwise by clicking the fx button on the Formula bar.  

Formula authoring enhancements

1. INSERT FUNCTION DIALOG
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Parentheses Coupling enhances the readability of long or complex 
formulae by visually highlighting the corresponding pair of parentheses 
based upon your cursor's position.  When you position your cursor 
within a set of parentheses, Parentheses Coupling intelligently highlights 

the corresponding closing parenthesis.  This visual indicator simplifies 
the identification of paired parentheses allowing you to concentrate on 
the specific section of the formula you are currently editing. 

Monospaced font introduces a fixed-width font experience in Formula Edit (F2) mode, improving the formula creation, editing and reading experience.  
This should enhance formula readability and complements features like parentheses coupling and value preview. 

Value Preview simplifies the evaluation and troubleshooting of formulae by providing real-time displays of the value associated with any part of a 
formula when you hover your mouse pointer over the section or select it.  This feature is currently rolling out to Windows users.  

By using the ‘Queries and Connections’ pane, you can:	

	 •	 delete a query

	 •	 rename a query

	 •	 duplicate a query

	 •	 drag and drop a query into a folder or change its order.

To open it, go to Data -> Queries & Connections.  This feature is already supported for Windows users.

2. PARENTHESES COUPLING

3. MONOSPACED FONT

4. VALUE PREVIEW

‘Queries and Connections’ Pane
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Microsoft has stated that checkboxes in cells is a top end user feature request for simplifying data entry and reducing user errors.  Therefore, the 
Excel team is adding a new Ribbon group called ‘Cell Controls’ to Excel for Windows.  The checkbox is the first control being added, but we are assured 
more is on the way.

It works as follows:

	 •	 Open an existing Excel workbook or create one

	 •	 On the Insert tab, select Checkbox in the ‘Cell Controls’ group.

This new functionality allows you to change Excel’s default behaviour and disable specific types of automatic data conversions as needed.  This way, 
you won’t need to worry about your data being converted to a format that you didn’t want and weren’t expecting.  This feature is currently rolling 
out to Windows and Mac users.

You should note that checkboxes appear in the selected cells.  Also, it may be seen that blank cells are automatically set to FALSE and any existing 
values and formulae in the cells remain the same.  Do remember checkbox formatting only works with Boolean values and blank cells.  Any other cell 
values, e.g. numbers and text, will be ignored. 

If the active cell has a checkbox, you can toggle the values of all selected checkboxes by pressing the space bar.

One other thing: you can’t directly remove checkbox formatting in a cell.  To do so, you’ll need to select Home -> Clear -> Clear Formats.  

This feature is available to Beta Channel users running Version 2310 (Build 196924.2000) or later.

Checkboxes in cells (Insiders)

Control data conversions
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You can enable or disable the following options:

	 •	 remove leading zeros from numerical text and convert to a number

	 •	 truncate numerical data to 15 digits of precision and convert to a number that may be displayed in scientific notation, if needed

	 •	 convert numerical data surrounding the letter “E” to a number displayed in scientific notation

	 •	 convert a continuous string of letters and numbers to a date.

When you select the ‘When loading a .csv file or similar file, notify me of any automatic number conversions’ check box, Excel displays a warning 
message when it detects that at least one of the optional automatic data conversions is enabled and about to occur when opening a .csv or .txt file.  
The message gives the ability to open the file once without converting the data.

The feature does not support disabling these conversions during macro execution.

This feature is available to all users running:

	 •	 Windows: Version 2309 (Build 16808.10000) or later

	 •	 Mac: Version 16.77 (Build 23091003) or later.

The web connector for Excel (alternatively known as ‘Get Data From Web’) is a tool that allows you to connect to websites and import data 
into your Excel workbook.  The Web connector leverages the abilities of Power Query in Excel to import data.  You may also refresh your data 
connection to get the latest updates from the selected websites.

Presently, this new Web connector will only be available in Excel for Windows.  Microsoft has plans to support Excel for Web and Excel for Mac in 
the future.

So what are the new features and enhancements?

	 •	 Suggested Tables: provides auto-detection of suggested tables, so you can easily structure your data
	 •	 Add Table Using Examples: allows you to provide examples of what you want your data to look like and select from AI-generated table 	
		  structures based on the examples provided.

The new Web connector in Excel is available as part of an Office 365 subscription.  

Here are some examples of using the new features.  In general, to use the Web connector for Excel, follow these steps:

	 1.	 Open Excel and create a new workbook or open an existing one

	 2.	 Go to the Data tab and click on From Web

	 3.	 Enter the Web page URL from which you'd like to extract data

		  Here, we'll use the Microsoft Store Web page, and show how this connector works.  If you want to follow along, you can use the 	
		  Microsoft Store URL that we use in this article:

		  https://www.microsoft.com/store/top-paid/games/xbox?category=classics 

	 4.	 When you select OK, you're taken to the Navigator dialog box where you can see Suggested Tables, which are autodetected tables from 	
	 	 the Web page.  In the case shown in the image below, five [5] tables were found

Web connector enhancements
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	 5.	 Alternatively, you can use the new ‘Add Table Using Examples’ feature, which presents an interactive window, where you can preview the 	
	 	 content of the Web page.  Simply enter sample values of the data you want to extract

	 6.	 In this example, you'll extract the Name and Price for each game on the page.  You can do that by specifying a couple of examples from 	
	 	 the page for each column.  As you enter examples, Power Query extracts data that fits the pattern of example entries using smart data 	
	 	 extraction algorithms.
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	 8.	 You can use Transform Data to shape your data with the Power Query Editor or Load to load the data to the Excel grid. 

Microsoft has announced a new and improved Narrator screen reader 
announcements in Excel for Windows.  Announcements are now more 
concise, customisable via keyboard shortcuts, and give more context 
about your spreadsheet.  These are new with the latest Windows.

A screen reader is assistive technology for people who prefer to hear 
content versus see it (or cannot see it).  For example, someone 
who is blind or who has low vision might use a screen reader to use 
their computer, read emails or navigate their Excel spreadsheet.   

The Windows operating system comes with a screen reader pre-installed, 
called Narrator.  You can turn on Narrator on any Windows device by 
pressing CTRL + WINDOWS + ENTER.

The Windows team has added a new experimental capability where app 
teams may optimise screen reader announcements based upon their 
scenarios, indicating what information is most relevant to them at any 
given time.  Here are some highlights:  

	 •	 more succinct reading when navigating in the grid and selecting cells, both within tables and in spreadsheets that do not use tables

	 •	 explicit announcements if a cell is blank

	 •	 succinct, explicit announcements when cells contain non-text or unclear information like conditional formatting, data validation and 	
	 	 formulae

	 •	 better handling of merged cells

	 •	 more information about collaborators on cells that someone else has selected or is editing

	 •	 customisable order of announcements for grid cells (e.g. “A1 blank” vs “blank A1”).

Before the update, Narrator used to say “A1, selected, editable, column 2 row 2, item, test, cell” when you navigated to cell A1 with data called test.  
Now it simply says “test, A1”.  This saves time for people who use screen readers and makes skimming a workbook to find the right information more 
efficient.

The updated version of the grid with all the new features is fast becoming too complicated to show clearly here.  Nonetheless, you can find the 
interactive links at aka.ms/ExcelFeaturesFlyer.

Optimising Screen Narrator Announcements

	 7.	 Once you're happy with the data extracted from the Web page, select OK to add the data to the list, and select the custom table that was 	
	 	 created:
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More next month, we’re sure.
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The A to Z of Excel Functions: MDETERM

In mathematics, especially in areas such as linear algebra, matrices may be used to solve simultaneous equations.  For the record, a matrix is not 
just a movie it’s a rectangular arrangement of mn elements, in the dimensions of m rows by n columns, e.g. a matrix A (say) may be represented as

It is often written in compact form as

Should the matrix be square (i.e. m =  n), then we may calculate a scalar value, known as the determinant which can be used to calculate matrix 
inverses, solve systems of linear equations and assist with calculus (unless it’s really stuck on your teeth).  For a square matrix A, this determinant is 
denoted by

det A or |A|

For example, with a 3 x 3 matrix, the determinant may be represented as

Some texts state that if the determinant is zero, the matrix inverse does not exist, but this is not strictly correct, as there may be another multiplicative 
identity for such a matrix – but that’s way beyond what we wish to talk about here!

To calculate it, the idea is as follows.  For a 2 x 2 matrix, 
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In this situation, each determinant of the three 2 × 2 matrices is called a minor of the matrix A.  This procedure can be extended to give a recursive 
definition for the determinant of an n × n matrix, known as a Laplace expansion.  It sounds a bit like my waistline.

The Excel function MDETERM returns the matrix determinant of an array.  It has the following syntax:

MDETERM(array)

where:

	 •	 array is required, and represents a numerical array with an equal number of rows and columns.

It should be noted that:

	 •	 array may be given as:

			   ○	 a cell range, e.g. A1:C3
			   ○	 an array constant, such as {1,2,3;4,5,6;7,8,9}
			   ○	 a name to either of these

	 •	 MDETERM returns the #VALUE! error when:

			   ○	 any cells in array are empty or contain text
			   ○	 array does not have an equal number of rows and columns

	 •	 the matrix determinant is a number derived from the values in the array.  For a three-row, three-column array, A1:C3, the determinant is  
		  defined as:

		  MDETERM(A1:C3) equals

		  A1 * (B2 * C3 – B3 * C2) + A2 * (B3 * C1 – B1 * C3) + A3 * (B1 * C2 – B2 * C1)

	 •	 matrix determinants are generally used for solving systems of mathematical equations that involve several variables

	 •	 MDETERM is calculated with an accuracy of approximately 16 digits, which may lead to a small numeric error when the calculation is not 	
		  complete.  For example, the determinant of a singular matrix may differ from zero by 1E-16.

As an example:

For a 3 x 3 matrix, the calculation extends:
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The A to Z of Excel Functions: MDURATION

Not to be confused with PDURATION, this function returns the modified 
Macauley duration for a security with an assumed par value of $100.

Whereas the modified duration measures the price sensitivity of a bond 
when there is a change in the yield to maturity, the (modified) Macauley 
duration calculates the weighted average time before a bondholder 
would receive the security’s cash flows.  It is frequently used by portfolio 
managers who wish to adopt what is known as an immunisation strategy 
(nothing to do with COVID-19).

The Macaulay duration is calculated by multiplying the time period 
by the periodic coupon payment and dividing the resulting value by 1 
plus the periodic yield raised to the time to maturity.  Next, the value 
is calculated for each period and added together.  Then, the resulting 
value is added to the total number of periods multiplied by the par value, 
divided by one [1], plus the periodic yield raised to the total number of 
periods.  This is then divided by the current bond price.

As stated above, the MDURATION function returns this modified Macauley duration for a security with an assumed par value of $100.  It employs 
the following syntax to operate:

MDURATION(settlement, maturity, coupon, yield, frequency, [basis])

The MDURATION function has the following arguments:

	 •	 settlement: this is required and represents the security's settlement date.  The security settlement date is the date after the issue date  
		  when the security is traded to the buyer

	 •	 maturity: this is also required, and is the security's maturity date, i.e. when the security expires
	 •	 coupon: again required, this is the security’s annual coupon rate
	 •	 yield: another required argument, this is the security’s annual yield
	 •	 frequency: another mandatory field, this is the number of coupon payments per year.  For annual payments, frequency is 1; for 		
		  semiannual, frequency is 2; for quarterly, frequency is 4.  These are the only options (see below)
	 •	 basis: the type of day count basis to use.  This is optional.  There are five options:
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Basis Day count basis

0 or omitted US (NASD) 30 / 360

1 Actual / actual

2 Actual / 360

3 Actual / 365

4 European 30 / 360

It should be further noted that: 

	 •	 Microsoft Excel stores dates as sequential serial numbers so they can be used in calculations. By default, January 1, 1900 is serial number 	
		  1, and January 1, 2008 is serial number 39448 because it is 39,448 days after January 1, 1900

	 •	 dates should be entered using the DATE function, or as results of other formulae or functions.  For example, use =DATE(2020,2,29) for the 	
		  29th of February 2020.  Problems may occur if dates are entered as text

	 •	 the settlement date is the date a buyer purchases a coupon, such as a bond.  The maturity date is the date when a coupon expires.  For 	
		  example, suppose a 30-year bond is issued on January 1, 2008, and is purchased by a buyer six months later.  The issue date would be 	
		  January 1, 2008, the settlement date would be July 1, 2008, and the maturity date would be January 1, 2038, 30 years after the January 1, 	
		  2008, issue date

	 •	 the arguments settlement, maturity, frequency and basis are truncated to integers

	 •	 if settlement or maturity is not a valid date, MDURATION returns the #VALUE! error value

	 •	 if yield is less than zero [0], MDURATION returns the #NUM! error value

	 •	 if frequency is any number other than 1, 2, or 4, MDURATION returns the #NUM! error value

	 •	 if basis < 0 or if basis > 4, MDURATION returns the #NUM! error value

	 •	 if settlement ≥ maturity, MDURATION returns the #NUM! error value

	 •	 Excel calculates MDURATION as follows:

Please see our example below: 
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The A to Z of Excel Functions: MEDIAN

In statistics and probability theory, the median is the value separating the 
higher half from the lower half of a data sample, population or probability 
distribution.  For a dataset, it may be thought of as "the middle" value.  
The basic feature of the median in describing data compared to the 
mean (often simply described as the "average") is that it is not skewed 
by a small proportion of extremely large or small values, and therefore 
provides a better representation of a "typical" value.  Median income, 
for example, may be a better way to suggest what a "typical" income 

is, because income distribution can be very skewed.  The median is of 
central importance in robust statistics, as it is the most resistant statistic, 
having a breakdown point of 50%: so long as no more than half the data 
are contaminated, the median is not an arbitrarily large or small result.

The MEDIAN function measures what is known as “central tendency”, 
which is the location of the centre of a group of numbers in a statistical 
distribution.  There are three common measures of central tendency:

The MEDIAN function measures what is known as “central tendency”, which is the location of the centre of a group of numbers in a statistical 
distribution.  There are three common measures of central tendency:

	 •	 Average: the arithmetic mean, calculated by adding a group of numbers and then dividing by the count of those numbers.  For example, 	
		  the average of 2, 3, 3, 5, 7, and 10 is 30 divided by 6, which is 5

	 •	 Median: the middle number of a group of numbers; that is, half the numbers have values that are greater than the median, and half the  
		  numbers have values that are less than the median. For example, the median of 2, 3, 3, 5, 7, and 10 is 4.  If the number of values in the  
		  selection is an even number, the median is defined as the midpoint between the two central numbers

	 •	 Mode: the most frequently occurring number in a group of numbers.  For example, the mode of 2, 3, 3, 5, 7, and 10 is 3.

For a symmetrical distribution of a group of numbers, these three measures of central tendency are all the same.  For a skewed distribution of a 
group of numbers, they can be different.

The MEDIAN function employs the following syntax to operate:

MEDIAN(number1, [number2], ...)

The MEDIAN function has the following arguments:

	 •	 number1: this is required.  The first number, cell reference, or range for which you want the median

	 •	 number2, …: this is optional.  Additional numbers, cell references or ranges for which you want the median, up to a maximum of 255 in total.
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It should be further noted that:

	 •	 if there is an even number of numbers in the set, then MEDIAN calculates the average of the two numbers in the middle

	 •	 arguments may either be numbers or names, ranges or cell references that contain numbers

	 •	 logical values and text representations of numbers that you type directly into the list of arguments are counted

	 •	 if a range or cell reference argument contains text, logical values, or empty cells, those values are ignored; however, cells with the value 	
		  zero are included

	 •	 arguments that are error values or text that cannot be translated into numbers cause errors.

You should bear in mind that when you calculate the median of cell 
values, there is a difference between empty cells and those containing 
the value zero.  If you have cleared the ‘Show a zero in cells that have a 
zero value’ check box in the Excel Options dialog box in Excel, you may 
not realise zeros are being included in calculating the average.  To locate 

the ‘Show a zero in cells that have a zero value’ check box, go to File -> 
Options -> Advanced and look under ‘Display options for this worksheet’.

Please see our final example below:

More Excel Functions next month.

Earlier in this month’s newsletter, we posed a challenging question: given a large table of data, how can we create a set of data validated cells that 
would automatically update when you select a particular item in the previous cell?

Beat the Boredom Suggested Solution
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We gave you several restrictions:

	 •	 the solution needed to be scalable.  Creating named ranges for each new type of make and model of vehicle was not acceptable, as it 	
		  requires additional work should the data update and change

	 •	 the solution needed to deal with the awkward situation that different models of cars would all be made in the same year, so you couldn’t  
		  just create a ‘2018’ named range.

The solution we have isn’t trivial, by any means.  It comes in two parts:

	 1.	 transforming the dataset into a more useable format for our purposes; and then
	 2.	 building the data validation framework.

The first task is to convert the dataset into something more useable.  Essentially, we need to establish a relationship between Make and Model, in a 
logical way.  This is actually surprisingly difficult.  It’s easy to use a Group By command in Power Query to get to here:

… but it’s quite difficult to establish it in two rows or two columns like the following:

To do this, we further grouped the previous values into Tables, as follows:

Then, we created a custom function that would transpose the table and keep only the models in the result:

Removing the Table column and expanding the TransposeTable column then gives us our final result.

1. Transforming the Dataset
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We then just needed to repeat these steps to create relationship tables between Model and Year, and Model, Year and Variant.

Once those tables are in place, we essentially need a tool that would look up the first value (the Make of a car) and use that to find the corresponding 
models associated with that make. To do this, we created a simple table to find the right values.

To populate this table, we’re using a simple INDEX(MATCH) (or XLOOKUP for those that have it) to look for the Make in the first column of our Make 
/ Model table, then specifying the column we want to pull in based on the index number in the list.  Therefore, the formula looks like this:

=INDEX(MakeModel, MATCH($H$2,MakeModel[Make],0),G22+1)

where G22 is the cell in the left-hand column of the above picture.

2. Building the Data Validation Framework
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This tells us what models are linked to an input make.  To turn this into a data validation list without the unused cells, we can create a Named Range 
called List_Models, that refers to the cells:

=OFFSET(Sheet1!$H$22,0,0,COUNTIF(Sheet1!$H$22:$H$31,"<>0"),1)

H22 is the first item (currently Fiesta) in a worksheet we have imaginatively called Sheet1.  Starting from there, it picks up a range that is X rows tall, 
being the number of non-zero values in the list (in this case, only two[2]).  We can then go into our input cell and set our data validation to point to 
the List_Models named range:

All we need to do is repeat this process for each different parameter that we have!  One Power Query output and one of these validation tables for 
every field after the first one.  Then, we have one named range for each of those fields.

This is a bit more convoluted than what you’ll find on Google, but it’s a far more flexible and scalable way to build multiple data validation lists that 
require very little (if any) additional rework once the file has been set up.

Until next month.

Summary

 

Location Course Date Date Duration Duration

Online (Australia) Excel Tips and Tricks 5 Dec 2023 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 1 Day

Online (Australia) Financial Modelling 6 - 7 Dec 2023 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 2 Days

Upcoming SumProduct Training Courses - COVID-19 update
Due to the COVID-19 pandemic that is currently spreading around 
the globe, we are suspending our in-person courses until further 
notice.  However, to accommodate the new working-from-home 
dynamic, we are switching our public and in-house courses to 
an online delivery stream, presented via Microsoft Teams, with 
a live presenter running through the same course material, 
downloadable workbooks to complete the hands-on exercises 
during the training session, and a recording of the sessions for 

your use within 1 month for you to refer back to in the event 
of technical difficulties.  To assist with the pacing and flow of 
the course, we will also have a moderator who will help answer 
questions during the course.

If you're still not sure how this will work, please contact us at 
training@sumproduct.com and we'll be happy to walk you 
through the process.
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

contact@sumproduct.com
www.sumproduct.com
+61 3 9020 2071

Sydney Address:	 SumProduct Pty Ltd,  Suite 803, Level 8, 276 Pitt Street, Sydney NSW 2000
New York Address:	 SumProduct Pty Ltd, 48 Wall Street, New York, NY, USA 10005
London Address:	 SumProduct Pty Ltd, Office 7, 3537 Ludgate Hill, London, EC4M 7JN, UK
Melbourne Address:	SumProduct Pty Ltd, Ground Floor, 470 St Kilda Road, Melbourne, VIC 3004
Registered Address:	SumProduct Pty Ltd, Level 14, 440 Collins Street, Melbourne, VIC 3000

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  We’ve started going through the 
alphabet actions.  It’s time to take the P this month…

Keystroke What it does

Page Down Page down

ALT + Page Down Page right

CTRL + Page Down Next sheet

SHIFT + Page Down Extend selection page down

ALT + SHIFT + Page Down Extend selection page right

CTRL + SHIFT + Page Down Extend selection one sheet down

Page Up Page up

ALT + Page Up Page left

CTRL + Page Up Previous sheet

SHIFT + Page Up Extend selection page up

ALT + SHIFT + Page Up Extend selection page left

CTRL + SHIFT + Page Up Extend selection one sheet up

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.
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